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Quickstart 
Guide

Welcome to your Second Life! This guide will help you get 
started fast, by explaining how to complete some of the 
most common tasks you’ll need to get the most out of your 
new Second Life. It might be helpful to print this guide for 
reference as you explore the World.
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Talk

Take

Sit Here Create

Open

More >

Pay Edit

Touch

Stand UpStand Up

Sit Contextual menus
(sit is selected) 

Right-click 
or Ctrl+click (On a Mac)

Left-click

Keyboard key

For help setting up your mic and headset, 
see Panel 8.

Dropdown menus
(Prefs. is selected) 

Interface button 

Edit >
Preferences

Symbols used in this guide Symbols used in this guide Symbols used in this guide

Keyboard Mic/Headset Viewer InterfaceMouse
You’ll use a mouse to click buttons, make 
selections, and interact with the Second 
Life Viewer interface.

You’ll use a keyboard to participate in text 
chats, IMs, for searching, and more. Lots 
of common tasks are easier once you 
learn keyboard shortcuts.

If you have a microphone and headphones 
(or speakers), you can participate in real-
time voice conversations with other users.

This Quickstart Guide will teach you how 
to find and use the most important tools in 
the Second Life Viewer software.
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Viewer contextual menus

Interact with objects you encounter,
such as buttons and links

Many objects you recieve will be
boxes containing other objects - 
open them to see their contents

Remove individual 
pieces of clothing 
and accessories

Put the selected 
object away in
your inventory

See your Friends list

Give money, usually
to purchase the 
selected object

View and edit 
your profile

Make changes to
your physical
appearance

Opens Gestures 
palette to see all 
available animations

Give a specified amount 
of L$ to the user

See a list of groups
you’re a member of

See the selected
user’s profile

Send an IM to the
selected user

Hides the messages of 
someone bothering you 
in Local Chat so you 
can ignore them

Ask the selected
user for permission
to add them to your
Friends list
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Object Self Others

Viewer interface overview
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Local Chat Say Gestures

Communicate Fly Snapshot Search Build Map Mini-Map Inventory

TalkLocal Chat SaySay Gestures

Communicate Fly Snapshot Search Build Map Mini-Map Inventory

Top Menu Bar

Bottom Toolbar

L$

Start
Flying

Show/Hide
Local Chat

Find People
Nearby

Purchase L$Current
Location

Manage 
Your Stuff

Open Search Window
See panel 12

Local Chat inputAccess Local Chat history Gestures

Media Controls
Voice Chat Controls
See panel 6

Open Friends list
See panel 9

L$ Balance

Talk

Start, stop, adjust volume for 
streaming audio and video

1 To access most of the features, tools and options in the Second Life Viewer, you’ll want to 
get comfortable finding your way around both the Top Menu Bar and the Bottom Toolbar.

As you explore the world of Second Life, you’ll encounter both people and 
objects to interact with. Many common actions and tools are accessed through contextual 
menus, which appear when you right-click on objects, yourself, or other users.
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Moving In Second Life, your avatar can walk, run, and even fly. 
If you prefer, you can also use an onscreen control panel 
to move around.

CommunicateCommunicate FlyFly SnapshotSnapshot

Walk forward

Turn left Turn right

Walk back

Stand UpStand Up

page
up

page
down

Sit

When sitting, you 
must click Stand Up 
before you can move 
again or fly 

Page Up and Page Down keys 
allow you to adjust your 
altitude and land comfortably

View >
Movement Controls

To access the onscreen 
movement control panel:

Click Fly to begin flying, 
and
to stop flying

Stop FlyingStop Flying

Seeing By default, you’ll see Second Life from just behind your avatar, but 
you can move and turn the camera around to look at whatever you 
like - including yourself.

Zoom in
Turn 

camera 
left

Turn 
camera 

right

Zoom out

alt

alt

Esc

Use alt plus the arrow 
keys to move the 
camera around you

Alt + click to focus the 
camera on a new point

Press Esc to return the 
camera to its position 
directly behind you

Zoom in/outRotate camera
in all directions

Move camera
in all directions

View >
Camera Controls

To access this panel:
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Walk Sit

Fly

Appearance In Second Life, you can look like – and wear – anything you want. Edit your Appearance to adjust your physical features and 
body, and select clothing, outfits and costumes to wear from your Inventory. You can customize your appearance however you 
like, or buy pre-designed avatars and outfits that other Residents have made.

Right-click an item in 
Inventory and choose 
Wear to put it on 

Mini-Map Inventory

Talk

Mini-Map

Manage your clothing and
avatars through the Inventory 

Inventory
File Create Sort

Suit Jacket

Clothing

Hiking Boots
Blue Jeans

New Shirt (worn)

All Items Recent Items

Free and paid avatars and
outfits are available in stores

To see a wide selection of
items to purchase, visit
XStreetSL.com

To purchase, you’ll need 
Linden Dollars, which can be 
bought by clicking        at the 
right of the Top Menu Bar

L$300

L$
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Set up for voice chat Tired of typing? To use the Voice features in Second Life, you’ll need to set up your microphone 
and headset. Just follow these simple steps, and you’ll be talking in no time.Create a SLurl to the 

selected location

Connect your microphone
or headset via audio-in or USB

Open the Viewer preferences

Edit >
Preferences

Preferences

Enable voice chat

Push to Talk

Privacy Options

Hear voice chat from camera position

NOTE: Running the Device Settings will temporarily disconnect you
from Voice Chat.

General

Input & Camera 

Network 

Web

Graphics

Audio & Video

Text Chat

Voice Chat

Communication

Popups

Skins

AboutAbout HelpHelp OKOK CancelCancelCancel CancelApplyApply

Device SettingsDevice Settings

Hear voice chat from avatar position

Voice Chat Device Settings

Audio Devices

Input Level

Input device (microphone):

Adjust the slider to control...

Default

Output device (speakers):
Default

Click Voice Chat

Make sure Enable voice chat
is checked

1

2

3

4 Click Device Settings, then change
both the input and output devices to
your preferred microphone and speakers
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Click OK - when you start talking, you’ll
see the voice indicator over your avatar’s
head (see 6: Local chat & voice)

7

If your mic is working,
you will see green bars
in the input level monitor

6

8

IMs & voice calls

Communicate

Multiple IMs appear as
tabs along bottom 

friend

Current tab highlighted Unread IM in flashing tab 

Start a voice call 

Enter message
and press send 

7Local chat & voice

Local ChatLocal Chat

CommunicateCommunicate FlyFly SnapshotSnapshot

Local Chat input

Show/hide 
Local Chat 
controls

Access Local Chat history

Mini-Map InventoryInventory

Talk

Voice Chat
Controls

Press Talk to use 
voice. Choose the lock 
to keep voice on

Mini-MapMini-Map

Active Voice
Voice
enabled

6
Express yourself! You can talk to the people around 
you through text-based Local Chat. If you have a 
microphone, you can also speak out loud using 
inworld voice.

Want to have a private conversation? Use instant 
messages or voice calls to talk to other users, no 
matter where they are in Second Life.

You can also IM users who aren’t nearby from your Friends list.
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Location The world of Second Life is gigantic, and getting bigger every day. If you want to visit a specific location, you can 
search for it on the Map. You can create and save Landmarks – bookmarks that will bring you back to specific 
locations. Use Landmarks to save time, and jump straight to your favorite places!

Teleport

SLurl
Use the Map to find
a specific location

You can Teleport to get from 
one location to another quickly.
To invite a friend to your 
location, open your Friends list, 
and click TeleportTeleport

You can use SLurl to teleport
to new locations. A SLurl is a 
web-based link to a location in 
Second Life. If you click a SLurl 
with Second Life open on your 
computer, you can immediately 
teleport to that location.

World Map

Person
Infohead

Telehub

Search Results:

Land for Sale
Events

Events (M)

Objects Terrain

SearchSearch

TeleportTeleport

Copy SLURL to clipboardCopy SLURL to clipboard

Brightonia

Landmarks
Online Friends

Brightonia
Bright Beach

Gestures

Build Map Mini-MapBuild Map Mini-Map

To return to Landmarks you’ve created,
open your                          and double-click
on any item in the Landmarks folder.

Instantly Teleport to a
specific location

Create a SLurl to the 
selected location

(Second Life URL)

Find the locations of
your online friends

Search for new locations,
people, and events

Find your previously
created landmarks

World >
Create Landmark Here

To create a landmark you can return to later:

InventoryInventory
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Make friends Second Life is a lot more fun when you have friends to explore it with. When you meet interesting 
people, you can ask for permission to add them to your Friends list. Then, use the Friends list to 
see which friends are online, send them messages, view their profiles and more.

friend you

Gulliver Fushikano
Stanford Larington
Dornati Fellows

Contacts Local Chat Pedro RoltinWendy Borma

Online friends 
appear in bold

Friends list

Send an IM

View a friend’s profile

Give a friend L$

Invite a friend to your 
current location

Remove/Add friends

9



Second Life Quickstart Guide 6

Help There’s a lot to learn in Second Life, but you’re never alone. If you have 
questions, need advice, or don’t know what to do, help is always waiting 
for you. Visit the Support Portal at secondlife.com/support to get help now!

Support
Portal

At secondlife.com/support, 
you will have access to the 
Knowledge Base, tickets, 
and Billing Support

Support
Tickets

If you can’t find the help you 
need in the Knowledge Base, 
you can submit a ticket to the 
Second Life Support Staff

support portal

http://www.secondlife.com/support/

Support

support portal

http://www.secondlife.com/support/

Support

http://server.iad.liveperson.net/930994

Live Chat Support

Hi, Can you help me?

Well, let me tell you...

Of course! What’s 
the problem?

Enter

http://server.iad.liveperson.net/930994

Live Chat Support

Hi, Can you help me?

Well, let me tell you...

Of course! What’s 
the problem?

Enter

Knowledge
Base

Find help videos and 
information on your 
avatar, Linden Dollars 
and more

Live
Chat

Premium members have 
access to Live Chat support 
in Second Life

Billing
Support

If you have a non-technical 
issue with your account, 
you can call the Billing Team 
toll free 24/7

11 What next? Second Life is packed with interesting things to do, people 
to meet and places to explore.  If you’re not sure what do to 
next, or want to see what’s new, you have lots of options.

To find new activities, events
and places to explore, visit:
secondlife.com/showcase 

Talk to other users in Second Life 
whenever you have questions

Say Gestures

Snapshot Search Build

Say Gestures

Snapshot Search Build

Use the Search feature to search 
all of Second Life

Search Second Life

Find: SearchSearch

Classi�eds EventsAll Showcase Land Sales Places People Groups

Any Category

Narrow your search results using the tabs at the top of the search window 
to specifically search for events, places, people and more

The                      tab displays 
interesting places and things 
going on in Second Life 

Showcase

12
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Appendix: Keyboard Shortcuts

Movement

Walk forward or

Walk backward or

Turn left or

Jump

Turn right or

Run Double-tap 

(Tap once) 

Hold or hold Fly up

Hold or hold Fly down

Toggle flying

Toggle between Friends and Groups Tabs
with  

or  

  

Always run +

+

View

System

Mouselook

Reset View

Look at Hold and click mouse to recenter

Zoom-in

Zoom-default

Toggle fullscreen

Zoom-out

Communicate

Show chat bar

Hide chat bar

Friends

(if displayed)

(if not displayed)

Local chat

Communicate

Gestures

Look at last speaker

+

General

Preferences

Help

World map

Inventory

Search

Mini-map

Teleport home

W

M

0

F1

Build B

S

A

D

W

+ 9

+

+

8

+ F

/

+ H

+ \

Upload image

Snapshot to disk + ‘“Ctrl

Quit Second Life

Key:

= Ctrl on a PC; Command on a Mac

= Alt on a PC; Option on a Mac

+ G

+ T

S

R

E

E

C

home

page
up

page
down

Esc

Esc

Alt

Enter

+ Shift

+ M+ Shift

+ H+ Shift

Take snapshot

Ctrl Cmd

Ctrl Cmd

Ctrl Cmd

Ctrl Cmd

Ctrl Cmd

Ctrl Cmd

+ PCtrl Cmd

+ FCtrl Cmd

+ MCtrl Cmd

+ QCtrl Cmd

Redo + YCtrl Cmd

+ ICtrl Cmd

+ UCtrl Cmd

Undo + ZCtrl Cmd

Copy + CCtrl Cmd

Cut + XCtrl Cmd

Paste + VCtrl Cmd

Close window + WCtrl Cmd

Deselect + ECtrl Cmd

Close all windows

Select all + ACtrl Cmd

Duplicate + DCtrl Cmd

Ctrl Cmd

Ctrl Cmd

+ S+ ShiftCtrl Cmd

+ W+ ShiftCtrl Cmd

Ctrl Cmd

Ctrl Cmd

Ctrl Cmd

Alt Opt Alt Opt

Alt Opt

Ctrl Cmd

Guide your avatar’s movements in Second Life.

Control your camera view and perspective in Second Life.

Access and participate in text-based Local Chat and Instant
Messages with other users.

Quick access to useful Second Life resources, interfaces and tools.

Basic system-wide functions that work in Second Life.


